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Copyright notice 

© European Union, 2023 

 

The Commission's reuse policy is implemented by the Commission Decision of 12 

December 2011 on the reuse of Commission documents. 

Unless otherwise indicated (e.g. in individual copyright notices), content owned by 

the EU within this publication is licensed under Creative Commons Attribution 4.0 

International (CC BY 4.0) licence. This means that reuse is allowed, provided 

appropriate credit is given and changes are indicated. 

You may be required to clear additional rights if a specific content depicts 

identifiable private individuals or includes third-party works. To use or reproduce 

content that is not owned by the EU, you may need to seek permission directly 

from the rightholders. Software or documents covered by industrial property rights, 

such as patents, trade marks, registered designs, logos and names, are excluded 

from the Commission's reuse policy and are not licensed to you. 

  

https://eur-lex.europa.eu/legal-content/EN/TXT/?uri=CELEX:32011D0833
https://eur-lex.europa.eu/legal-content/EN/TXT/?uri=CELEX:32011D0833
https://creativecommons.org/licenses/by/4.0/
https://creativecommons.org/licenses/by/4.0/
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Introduction 

Web accessibility is intended to allow everyone, including vulnerable users and 

people with disabilities – who account for an estimated 100 million people in the EU 

– to perceive, understand, navigate and interact with the internet, and to ensure 

access, on an equal basis with others, to information and communication 

technologies. 

In the EU, the Web Accessibility Directive (Directive (EU) 2016/2102) has been in 

force since 22 December 2016 and aims to provide people with disabilities with 

better access to websites and mobile apps of public services. The Directive reflects 

the European Commission’s ongoing efforts to build a social and inclusive European 

'Union of equality', where all Europeans take a full and active part in the digital 

economy and society, and where everyone can fully benefit from the opportunities 

provided by the digital world. 

The Directive requires websites and apps of public sector bodies to meet specific 

technical accessibility standards with a limited number of exceptions. It is 

complementary to the more recent and broader European Accessibility Act, aiming 

for more accessible products and services in the internal market by removing 

existing barriers. 

After a round of public consultation that took place from July to October 2021, the 

review of the application of the Web Accessibility Directive by the European 

Commission is now available. 

As part of BIK Phase 3 and Phase 4, members of the BIK team have been trained 

on producing accessible content and adapting it to different media outlets. They 

also received audits and reports from external accessibility experts Eleven Ways on 

the overall performance of the Better Internet for Kids (BIK) portal and related 

minisites, to ensure we meet the current standards listed in the Directive for our 

content. 

Digital accessibility has become even more important with the pandemic due to the 

rapid growth of information and interactive services provided through the web and 

https://eur-lex.europa.eu/eli/dir/2016/2102/oj
https://www.etsi.org/deliver/etsi_en/301500_301599/301549/03.02.01_60/en_301549v030201p.pdf
https://www.etsi.org/deliver/etsi_en/301500_301599/301549/03.02.01_60/en_301549v030201p.pdf
https://ec.europa.eu/social/main.jsp?catId=1202
https://digital-strategy.ec.europa.eu/en/policies/web-accessibility#Review%20of%20The%20Web%20Accessibility%20Directive
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mobile devices, together with a substantial increase in the time spent in the digital 

environment. 

Against this backdrop, the good practice guideline (GPG) seeks to build on the 

existing resources and provide guidance and support primarily aimed at the Insafe 

network of Safer Internet Centres (SICs) to ensure that web content is accessible 

to all, including vulnerable users and people with disabilities. It provides a non-

exhaustive checklist of criteria and requirements to be met for accessibility 

compliance, as well as an easy-to-follow walkthrough on how to address the most 

common issues in creating accessible websites and documents. 

It also includes a detailed case study based on the production of the accessible, 

child-friendly version of the new BIK+ strategy. In May 2022, the European 

Commission adopted a new European strategy for a Better Internet for Kids (BIK+), 

to improve age-appropriate digital services and to ensure that every child is 

protected, empowered and respected online. As part of this line of activities, we 

were tasked with the production of a child-friendly version of the strategy 

illustrating the main pillars of the strategy and targeting a younger audience of 

children and young people up to 18 years of age, and to provide an accessible PDF 

version of it. The case study included in this guide provides guidance, tips and 

insights on how to produce an accessible PDF document to be accessed online and 

compatible with screen readers for blind or visually impaired individuals. 

In the production of this guideline, we issued a survey to SICs, to firstly assess 

their understanding and existing knowledge of accessibility requirements, and then 

to investigate the efforts and lines of work (if any) that are already in place at the 

national level for each SIC. What is their general approach to accessibility 

concerns? Are their websites and materials compliant and, if so, how do they check 

for compliance? Do they consult with target audiences to identify specific 

accessibility concerns? In such a manner, we were able to effectively evaluate 

practical needs and issues of real concern for SICs and determine the direction of 

this final GPG, thus providing better support and guidance, and helping SICs to 

navigate the overabundance of technical information available on the internet on 

the subject. Our aim for the good practice guideline is to contain tangible, valuable 

https://digital-strategy.ec.europa.eu/en/library/digital-decade-children-and-youth-new-european-strategy-better-internet-kids-bik
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information and tips tailored to the needs of the surveyed SICs, and possibly to a 

wider audience if applicable. 

The survey, conducted in December 2022, identified three main areas of concern 

for the Insafe network: websites, PDFs and Word documents, and social 

media content. Most SICs expressed their desire to focus their accessibility efforts 

in these areas, which are therefore explored in detail in this guide. In terms of 

existing knowledge and expertise, most SICs evaluate their current level of 

knowledge of accessibility criteria and requirements as low or medium, with most of 

the knowledge being self-taught within their teams, and often having to rely on 

external experts at an additional cost. Even when SICs are aware of the main 

accessibility criteria, they oftentimes face difficulties when it comes to practically 

implementing technical/content edits or fixes to ensure that their content is 

compliant. Assessment of accessibility compliance seems to be another caveat, as 

most SICs find themselves unable to autonomously check for accessibility or are 

unaware of the tools needed to perform an accessibility check. 

  



 

8 

 

Ensuring accessibility in content for all 
 
      

1.Checklist of main criteria for 
accessibility compliance 
While it is clear that the web offers unprecedented opportunities to everyone, and 

especially to people with disabilities and vulnerable users, with assistive technology 

such as screen reader software, motor disability assistive devices, captions and 

transcripts of multimedia, the potential of the online world to be beneficial to people 

with disabilities and vulnerable users is still largely unrealised. 

The categories of disability considered by the Web Accessibility Directive include 

visual (blindness, low vision, colour-blindness), auditory (deafness, hard-of-

hearing), motor (inability to use pointing devices, slow response time, limited 

mobility and/or fine motor control), and cognitive (learning disabilities, inability to 

remember or focus, distractibility) – all of which require specific strategies and 

approaches in content design. 

In addition, there are different barriers to accessibility: temporary (e.g. a 

temporary injury such as a broken bone), situational (e.g. you are in a situation 

where you are holding a baby in your arms, and are thus unable to use them), and 

permanent (e.g. an amputation). All of these instances can benefit from better 

accessibility. Furthermore, people in the same category of disability may have 

different preferences and expectations (e.g. some deaf users might prefer watching 

videos with a sign language interpreter, some might prefer reading audio 

descriptions), hence the importance of not assuming users' needs based solely on 

their disability, and the effort on building content accessible to everyone. 

The Web Content Accessibility Guidelines (WCAG) are based on four guiding 

principles: 

● Perceivable: it should be available to the senses (primarily hearing and 

vision) through the browser or through assistive technologies. 

● Operable: users should be able to interact with all controls and elements of 

the content item using the mouse, keyboard or an assistive device. 

● Understandable: content should be clear and avoid confusion and 

ambiguity. 

https://www.w3.org/WAI/
https://www.w3.org/WAI/people-use-web/abilities-barriers/
https://www.w3.org/WAI/WCAG21/quickref/
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● Robust: users should be able to access the content using a wide range of 

technologies. 

This section provides an overview of the main criteria and requirements for 

accessibility compliance, divided into three macro categories: web content, 

documents (PDFs and Word documents), and videos and other media, in this order. 

For each, a brief definition is included, as well as the vulnerable groups of users 

who are mostly affected as a result. 

It is important to bear in mind that the good practices collected in this guide are 

often cross-platform, meaning that most good practices in section 1.1 can be 

adapted to the following sections 1.2, 1.3 and 1.4, which collect tips and good 

practices specific to Word documents, PDFs and other media. 

As mentioned in the introduction, the guide is intended to be beneficial to the 

widest possible audience with a limited pre-existing knowledge of accessibility – for 

this reason, most good practices mentioned in this guide can autonomously be 

implemented by content managers and content producers, but for some you might 

need the support of a web designer. The list of best practices is non-exhaustive, 

and there are more practices to be implemented to make web content accessible 

than the ones mentioned in this guide – however, this guide represents a good 

starting point for content managers and editors. 

1.1 Accessibility of web content 

You will find below a list of good practices and tips on how to ensure accessibility of 

your web content. As previously mentioned, please bear in mind that most good 

practices are intended for content managers and editors, whereas for a few more 

technical instances you might need the help of a web designer. As a matter of fact, 

when it comes to ensuring accessibility, there are two environments to work in: the 

content production/content management area (i.e the “readable” text and content 

that you see on screen), and the web design/web development environment, or the 

“back-end”, which is more technical. 
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1.1.1 Text elements in articles or other web content 

When it comes to text elements as part of a webpage, is it important to be mindful 

of: 

1. Logical content structure. Headings, lists and other structural elements 

provide meaning and structure to the content of webpages. Is it especially 

useful for people with visual impairments. A proper structure provides users 

of assistive technologies such as screen readers an overview of the page 

content. 

2. Forms. Ensure all users are able to fill in and submit online forms by making 

them keyboard accessible, logical and easy to understand and complete. 

Identify instructions and required fields clearly. Ensure that the reading and 

navigation order are intuitive and logical. 

3. Simple language. Use a clear, conversational language with everyday words 

that every user can understand after reading the text content just once, and 

favour active verb forms over passive verb forms. Avoid using jargon and 

slang terms, and write cohesive and logical paragraphs based on a single 

main idea or topic. 

4. Readability. Use a clear, easy-to-read font and ensure that the font size is 

sufficient (and usually a minimum of 11pt). 

When it comes to font size, there is actually no minimum size required by the 

WCAG. However, as a good practice, you should avoid anything lower than 9pt 

(12px). Therefore, 11pt (15px) is a good recommendation. 

1.1.1.1 Logical content structure 

Enforce these good practices to ensure a logical content structure in any web 

content: 

● Provide unique and informative page titles. Each webpage should have a 

short title describing the content and distinguishing it from other webpages. 

Make sure to include the most relevant information first. The page title is not 

to be confused with the main heading of the page, although oftentimes the 

content of the two might be similar. A page title would typically follow this 

format: [Page Title] | [Website name] 

 

Please note that oftentimes, the CMS (Content Management System, e.g. 
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WordPress, Drupal, Liferay) will generate the page title based on the title of 

the article written by the content manager. 

● Use headings to convey structure and meaning, to group paragraphs that 

are related, to clearly identify each section of the webpage and to provide an 

outline of the content. Use heading levels in a logical decreasing order (Level 

1, then Level 2, etc...). Don't use headings or skip headings levels for 

decorative reasons. 

● Use proper list elements to structure a list (e.g. don't write "-" or "1., 2., 3." 

in normal text paragraphs to imitate a bulleted or numbered list). 

● Structure the text in paragraphs. 

1.1.1.2 Forms 

Be mindful of these good practices when building online forms: 

● Provide clear instructions. Especially in forms or other webpages that 

require some interaction from the user, make sure that instructions and error 

messages are easy to understand, clear and avoid unnecessary technical 

jargon. Describe what is required by the user in detail and, when it comes to 

error messages, indicate what the problem is and, possibly, how to fix it.  

● Ensure that every field has a visible label. A placeholder text inside the field 

is not sufficient. 

● Provide clear labels for buttons. Avoid vague calls-to-action such as 

“Continue” and favour more specific labels (e.g. "Next step" or "Submit"). 

1.1.1.3 Simple language 

Enforce these good practices when writing content: 

● Clear and concise content. Write your content using clear, short sentences 

and paragraphs, and break down complex content into smaller paragraphs. 

When it comes to acronyms, while it would be best to avoid them altogether 

(except where the acronym might be more known than its definition, for 

example with UNICEF), if you have to use acronyms, you should expand them 

on the first use. In addition, consider a glossary for specific terms or 

acronyms the users may not be familiar with. Use list formatting and images, 

illustrations, symbols, audio and video to help clarify the meaning and keep 

the content concise. 

● Language. The page language needs to be specified. Please note that the 

page language is usually set by the web developer, and you might need their 

support to set language-related parameters. In addition, if there are any 

content items inside the page that are in a different language than the one 
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specified on the page level, they should be specified as well with a "lang" 

attribute in HTML. In case of a CMS for a multilingual website, the content 

manager either needs to specify in which language they're writing the article 

(and thus the back-end language would need to match), or will need to 

access different back-end URL/environments depending on the language 

they're writing in. 

In addition, if there are any content items inside the page that are in a 

different language than the one specified on the page level (for example, a 

sentence in English in a page written in French), the copywriter can add the 

following "<span lang="en">My Text</span>" to the HTML mode that most 

web editors and CMS have. 

1.1.1.4 Readability 

Enforce these good practices to ensure readability: 

● Avoid decorative fonts. While there is no specific rules regarding fonts’ 

compliance, there are, however, good practices to ensure a better readability 

of text for all. Script, decorative or handwritten fonts should not be used. 

Instead, use serif or sans-serif fonts that have distinct letters (e.g. uppercase 

“i” and lowercase “l” should look different). For example, some common fonts 

such as Times New Roman, Calibri, Arial, Helvetica, Verdana, Tahoma are all 

compliant. 

● Avoid writing in uppercase. Text written fully in capital letters can be 

difficult to read for people with reading disabilities such as dyslexia, because 

the letters are all the same height. 

● Text alignment. Align text on the left (or right depending on the language). 

Justified text and centred alignment are to be avoided as they can negatively 

impact readability. 

● Ensure that the text colour meets a sufficient contrast ratio with its 

background. Enough contrast is a ratio of 4.5:1 for body text, and 3:1 for 

large text. 

See section 1.1.4 for more detailed information about colour contrast in text 

elements. Read more about typefaces and fonts here, and discover more about how 

different fonts impact dyslexic users. 

https://webaim.org/techniques/fonts/
https://www.a11yproject.com/posts/dyslexia-fonts/
https://www.a11yproject.com/posts/dyslexia-fonts/
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1.1.1.5 Common accessibility issues in text elements 

● Using various colours in the body text to convey meaning (e.g. red for 

important), sometimes not meeting the minimum contrast ratio either. While 

this is a common practice, colour shouldn’t be used as the only way to convey 

information as it would not be available to screen reader users and can be 

troublesome for colour blind users. 

● Changing the font size and the weight of a text to give it the appearance of 

a heading, instead of formatting it semantically as a heading. Visual cues 

such as the appearance of a text don't indicate the role of the element to 

assistive technologies. Specifying in the code that a piece of text is a heading 

allows blind users to access this information. 

● Adding text in a language different from the document’s language 

without specifying the language of that part. As seen in section 1.1.1.3, 

setting the language in a webpage needs the support of a web developer. 

● Using acronyms or abbreviations without clarifying their meaning at least 

once. 

1.1.2 Images in articles or other web content 

All images that provide information that is not already conveyed by text in a 

webpage should include a text alternative (alt text). A textual description can be 

provided inside an HTML attribute "alt" on an image for users with visual 

impairments. Assistive technology like screen readers or other text-to-speech 

software will read the alt text instead of the image. In addition to the previous, alt 

text can be helpful if an image fails to load on a browser, and it is factored in by 

search engines to better assess a webpage’s content and purpose. For the same 

reason, accessible images are also beneficial for search engine optimisation, as the 

images will become indexable by search engines. 

Alternative text should represent the content and function of the image, rather than 

simply stating what it depicts. In general: 

● Prioritise information in alt text, make sure to put the most important 

information at the beginning. 

● Length. Alt text should be the most concise description possible of the 

purpose of the image, and it shouldn’t require more than a short phrase or 

sentence. 
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● Punctuation. Punctuation makes the information easier to understand, 

especially for screen reader users. In particular, make sure to include a space 

character when there is none between the image and the following text, to 

avoid having words running together when read by a screen reader. 

● Redundant information. There is no need to include words such as “icon”, 

“picture” or “image of” as screen readers announce the presence of an image 

before reading the alt text. More specific terms such as “painting”, 

“photograph” or “illustration” may be used if it’s meaningful to distinguish 

between each. 

You can also follow this guide with picture and alt text examples for each category 

of image to better understand the different types of images and the function of the 

alt text. 

1.1.2.1 Different types of images 

Images have been categorised into different types, and each require a specific alt 

text attribute: 

● Informative images. They convey a simple information or concept to be 

expressed in a short phrase or sentence. Alt text should convey the meaning 

or content that is visually displayed, which is typically more than a literal 

description of the image. For example, images used to label information or a 

file format, images conveying a specific emotion or impression. 

● Decorative images. When the only purpose of an image is to add visual 

decoration to the page, rather than conveying information, you should 

provide a null (empty) alt text (alt=””) so that assistive technologies such as 

screen readers will ignore the image and not distract users with redundant 

information. Decorative images may have visual elements such as borders or 

corners and be part of page design, or may be sufficiently described by the 

adjacent text in the body of the webpage. 

● Functional images. The alt text of a functional image which is used as a link 

or as a button should describe the functionality of the link or button rather 

than the image itself. For example, a printer icon to represent the print 

function or a button to submit a form are functional images, used to initiate 

actions. 

● Images of text. Images of text are when readable text is presented in an 

image. Unless the image is a logo, you should avoid text images as they can’t 

be resized without losing clarity. If used, alt text should contain the same 

words as in the image. 

https://webaim.org/techniques/alttext/
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● Complex images. These are typically graphs, diagrams, charts, maps or 

other illustrations conveying complex, detailed information where the user is 

asked to be able to understand the image autonomously. A two-part text 

alternative is required in this case: the first part is a short description to 

identify the image and, when needed, locate the long description; the second 

part is the long description, which explains the essential information and 

content conveyed by the complex image, for example the interpretation of a 

graph. This can be done in different ways: 

○ A text link next to the image is provided, redirecting to a separate web 

page or a section of the same containing the long description. 

○ describe the location of the long description (somewhere on the same 

web page as the image) in the alt text. 

● Groups of images. If a group of images are conveying a single piece of 

information, the alt text for one image should convey the information for the 

entire collection, while the other have a null (empty) alt text. 

● Image maps. An image map is an image divided into several different 

clickable regions, which usually link to other pages. For these, you should 

include alt text for the image altogether, to provide general context and 

information, and for each of the selectable areas to convey information about 

the link destination or interaction that will be triggered. 

Let’s see a practical example of four different image types from European 

Schoolnet’s EMINENT 2022 webpage. Each image type is identified by a number in 

the pictures below. 

http://www.eun.org/eminent-2022
http://www.eun.org/eminent-2022
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1. Informative image: at the top and bottom of the webpage, the European 

Schoolnet logo should have as alt text: "European Schoolnet". 

2. Decorative image: Each entry in the section "Publications on data in 

education" of the webpage has a decorative image. 

3. Functional image: The social media icons in the top right corner of the 

webpage should have as alt text: "Follow us on [platform name]". 

4. Images of text: The first image of the article should have as alt text: 

"Eminent 2022, Responsible & smart use of data in education, 6-7 December, 

Dublin". 

1.1.2.2 Alt text decision tree 

The ultimate judgement on the type of image is made by authors and content 

editors. This alt text decision tree provides the step-by-step logical reasoning to 

determine the kind of image, and thus to determine the appropriate alt text to go 

with it. An easy way to approach the alt text decision tree is the following: 

https://www.w3.org/WAI/tutorials/images/decision-tree/
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● If the image is informative, provide a text description in the alt attribute of 

the image element. Images of text (e.g. a logo) are always considered 

informative. 

● If the image is decorative, provide an empty alt attribute so that the image 

can be ignored by screen readers. 

● If the image is functional, provide a text in the alt attribute that describes 

its function (e.g. a button "Add to basket" with a cart icon). 

If no alt attribute is provided, screen readers will try to guess the image's content 

by reading its file name instead, but providing meaningful alt text should always be 

the priority. Nonetheless, when it comes to file names, the good practice is to 

always provide meaningful names also, such as “Eiffel_Tower.jpg” instead of 

“img1134958957.jpg”. 

1.1.2.3 Common accessibility issues in images 

● Providing a descriptive alt attribute on decorative images. Let screen readers 

ignore decorative content. 

● Specifying “Image of” in the text alternative. The screen reader can identify 

that the element is an image. 

● Using an image of text instead of plain text for headings. They should always 

be avoided (exceptions being logotypes where the presentation cannot be 

altered). 

1.1.3 Links 

Links in webpages allow the users to visit another webpage, send an email, or 

navigate to different sections of the same webpage. In order for links to be 

accessible, they should always make sense as standalone information, be 

unambiguous and intuitive. Phrasing such as “click here” and “more” should be 

avoided. Other criteria to keep in mind include: 

● Keyboard accessibility of links. Users should be able to select and 

navigate to each and every link on a webpage using the keyboard alone. This 

can be easily checked by using the "tab" key on the keyboard to navigate to 

the next interactive item, and by pressing "shift+tab" to navigate to the 

previous. Test if you can tabulate in a logical order through every element 

that should receive the focus, and use “Enter” or “Space” to interact with 

links/buttons/controls. 
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● Screen readers. Most screen readers will say “link” before reading each link 

out loud. Therefore, there is no need to include “link” in the link text as that 

would be redundant. Moreover, screen reader users might navigate from link 

to link as a way to skim web content, thus the need for links to make sense 

out of context and to include all relevant information related to a specific link 

before the link itself. 

● The hyperlink text needs to be descriptive of the link. 

Examples of bad link texts are (and should be avoided): 

● “Click here” 

● “Read more” 

● “Buy tickets to Mars here”. 

Examples of good link texts are: 

● “Find out more about the HTML language” 

● “Read more about how to eat healthy” 

● “Buy tickets to Mars here”. 

More examples and further explanations on good and bad link texts are available. 

1.1.3.1 Common accessibility issues in links 

● Displaying the link URL in plain text instead of an appropriate link text. 

Screen readers will read out the entire URL. This means that in any webpage, 

or document, you should avoid displaying links URLs such as 

“https://www.eun.org/home", for example. Instead, you should write 

"European Schoolnet Homepage" and make it a link. 

● Relying only on colour or location alone to identify links from non-link 

text. Links should be identifiable through a consistent visual cue such as an 

underline or an arrow icon. 

● Link text such as “Click here to access the PDF” instead of simply “Access 

the PDF”. 

1.1.4 Colour contrast and other visual elements 

Providing a sufficient colour contrast ratio between text colours and background 

colours, and between other elements of the webpage and the background (such as 

icons, text fields’ outlines, buttons, etc.) is essential so that every sighted user can 

read and understand the content and visual information correctly. 

https://www.w3schools.com/accessibility/accessibility_link_text.php
https://www.eun.org/home
https://www.eun.org/home
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Other elements to be mindful of include: 

● Do not rely on colour alone to convey meaning (for text elements). 

While using colour can help distinguish different parts of the text or different 

elements conveying different meanings, do not use it as the only way to 

convey information as it would not be available to screen reader users and 

troublesome for colour blind users. A few examples include using colour as 

the only way to identify links within the document, or relying on red/green to 

identify errors or required fields in forms without text to support the 

information to be conveyed. 

● Avoid blinking/flashing content. Content blinking or flashing more than 

three times per second could potentially trigger seizures. This content should 

always be avoided. If it’ not possible to avoid it all, it should be hidden behind 

an explicit action such as a link or an expand/collapse button. 

• Animated content. Any animated content that starts automatically and 

plays for more than five seconds should provide a way for the user to pause 

it. In the case of animated gifs, they should be avoided or embedded in a way 

that prevents them from looping. 

In addition, you should be mindful of how quickly different readers and users 

can read and digest information. One example of this are self-scrolling 

carousels, where the slides may sometimes change too fast – hence the 

necessity to provide a “pause” option to allow everyone to go through the 

content at their own pace. 

Colour accessibility test. In order to test the colour accessibility of your 

webpage, you should first identify the hex codes of the colours of every item (text 

or other element) on your page. Hex codes are six-character codes beginning with 

a hash that uniquely identify colours (e.g. #FFFFFF is white). If you don’t already 

know the hex codes, you will need to use a colour picker tool (for example, 

ColorZilla as a browser extension). Next, you will need a colour contrast checker to 

assess the level of conformance, and if needed increase the opacity of the text until 

it meets the requirements. There are several levels of conformance depending also 

on the type and font of the text against the background colour. The Level AA 

requires a contrast ratio of at least 4.5:1. There are a few exceptions and specific 

cases to be taken into consideration: 

https://www.colorzilla.com/
https://www.colorzilla.com/
https://www.colorzilla.com/
https://webaim.org/resources/contrastchecker/
https://webaim.org/resources/contrastchecker/
https://www.w3.org/TR/WCAG21/#contrast-minimum
https://www.w3.org/TR/WCAG21/#contrast-minimum
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● Text effects such as outlines or text borders can impact the perceived 

contrast. The colour of an outline or border can be used as the foreground 

colour when measuring contrast, and any text glow or halo around the letters 

can be considered as the background colour. 

● Exceptions include large text (as it’s easier to read, it requires a lower ratio 

of 3:1), “incidental” text that doesn’t have to meet the requirements and 

consisting of text of an inactive element, purely decorative text that doesn’t 

convey information, text that is not visible to anyone, text that is part of a 

brand or logo name. 

Non-text elements. When measuring the contrast of a non-text element, such as 

an icon, there might be a different contrast on one side than the other, or it might 

contain different colours that require multiple contrast ratios among different 

combinations of colours to be checked. 

1.1.4.1 Common accessibility issues in non-text elements 

● Gifs inside articles. Animated gifs that loop infinitely can distract users 

trying to read the content. Favour still images instead. 

● Form elements such as text fields or unselected controls in light grey. 

These often don’t have sufficient colour contrast, so they are difficult to 

situate for seniors and other users with low vision. 

● Videos in auto-play with no way to pause them. Don’t automatically 

start playing a video or, if they are shorter than 5 seconds, don’t make them 

loop. 

1.1.5 Keyboard accessibility 

People with specific needs or disabilities navigating your site may not be able to use 

a mouse or other pointing device. Therefore, all functionality on your website 

should be accessible using the keyboard alone. Usually, the tab key should allow 

users to jump between all interactive elements on the page, and the Enter or Space 

key should allow users to "click on” the selected element. 

Keyboard accessibility also implies providing support to users in their navigation, 

for example by helping them know where they are located in the webpage and what 

they can access. This is made possible by ensuring that the elements that receive 

the focus have a visible focus indicator, as well as maintaining a clear page 
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structure with a clear title and headings, and meaningful links. While setting focus 

indicators is quite complex and might require the support of a web developer, some 

good practices to follow are: 

● Make sure each interactive element that receives the focus has a visible focus 

indicator – i.e. do not disable it. 

● The appearance of the focus indicator should meet the minimum contrast 

ratio of 3:1 with its background. Sometimes, the browser's default focus 

indicator is not enough against different background colours. 

You can read more about the focus appearance requirements and find further 

recommendations on focus appearance here. 

Content managers should also be aware that embedding external content 

through an iframe in a page can bring new accessibility issues. For instance, an 

embedded map that does not allow panning by keyboard, or a video player that 

uses keyboard shortcuts that interfere with screen reader shortcuts. Those issues 

can often be solved by adding a simple attribute or additional script in the iframe. 

This aspect is also quite complex and will need the support of a web developer, as it 

depends on the API (Application Programming Interface) of each external content 

type and is usually dealt with on a case-by-case basis. However, you can find more 

information and guidance on the most commonly used external content types that 

get embedded in webpages: YouTube and Google Maps. 

1.2 Accessibility of Word documents 

As mentioned in the introduction, most of the good practices mentioned in section 

1.1 are cross-platform, and therefore apply to creating accessible Word documents 

as well. Think of, for example, colour contrast between text and non-text elements, 

readability, logical content structure with headings and sub-headings, links, and alt 

text for images. To avoid being repetitive, this section will explore good practices 

specifically related to Word documents, as an expansion to the points already 

detailed in section 1.1. 

Writing with accessibility in mind means that you are trying to ensure that your 

content can be read and understood by as wide an audience as possible. As 

https://www.w3.org/WAI/WCAG22/Understanding/focus-appearance-minimum
https://www.sarasoueidan.com/blog/focus-indicators/
https://www.sarasoueidan.com/blog/focus-indicators/
https://www.200ok.nl/tips/youtube-embed/
https://cloud.google.com/blog/products/maps-platform/improved-accessibility-maps-javascript-api
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mentioned in section 1.1, when it comes to formatting text elements in a Word 

document, it is important to be mindful of: 

● Headings. The heading structure is one of the most important accessibility 

aspects of a text document, given that users who are able to read will usually 

skim through the headings of the document to get an idea of its structure and 

content. Similarly, screen readers will use headings to navigate through the 

document. 

● Lists and columns. These also contribute to adding a hierarchical structure 

to the document, and are particularly useful to break down content-heavy 

information, thus making it easier to read and follow. There are two types of 

lists in Word documents: bulleted and numbered. 

● Simple language. Plain and simple language means communication that the 

reader can understand the first time they read it. It can be defined as a clear, 

conversational style using everyday words, and preferring the use of active 

voice (active verb forms) over passive. 

● Readability. Use a clear, easy-to-read font and ensure that the font size is 

sufficient (and usually a minimum of 11pt), provide sufficient colour contrast 

ratio between text colours and background colours. Do not use colour as the 

only way to convey information (e.g. to identify links within the document). 

Refer back to section 1.1.1.4 for further recommendations on readability. 

● Table of contents. For long documents, provide a table of contents to help 

navigate the document and facilitate keyboard navigation. 

1.2.1 Text formatting  

Be mindful of the following good practices when formatting text in Word 

documents: 

● Text justification. Align text on the left (or right depending on the 

language). Justified text and centred alignment should be avoided for 

readability. 

● Line spacing. Adjust the paragraph spacing or line spacing when necessary, 

and avoid empty carriage returns (pressing the enter key multiple times). 

1.2.2 Visual elements in Word documents 

Similarly to web pages, any image included in the document should include 

alternative text. Alt text is a text alternative defined for images, to describe the 

https://webaim.org/resources/contrastchecker/
https://webaim.org/resources/contrastchecker/
https://webaim.org/resources/contrastchecker/
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information delivered by an image to those users with visual impairments. Assistive 

technology like screen readers or other text-to-speech software will read the alt 

text instead of the image. 

When using Word or another text processor, you will be typically asked to add a 

text alternative directly in the software. Refer to section 1.1.2 to learn more about 

the alt text decision tree and how to correctly provide alternative text to images in 

documents. 

1.2.3 Links in Word documents 

Similarly to links in web content, in Word documents links serve the purpose of 

allowing the reader to visit a webpage, send an email, or to navigate to different 

sections or bookmarks of the same document. Links should always make sense as 

standalone information. 

In addition, it might be useful to provide the full URL in brackets after the 

descriptive link, especially if the document will be printed out. This way, the URL 

inside the link will be explicitly available should users be unable to click on the link. 

Refer back to section 1.1.3 for more good practices about links. 

1.2.4 Data tables 

A data table is a grid within a Word document that contains information which is 

logically organised into columns and rows. While sighted users can visually scan 

and interpret the information in a table, visually impaired users are not able to 

make the needed visual associations, and proper markup is needed for screen 

readers to navigate through data tables. When formatting a table in a document, 

you should be mindful of: 

● Table summary. Make sure to provide a description of the information 

conveyed by the table. 

● First rows and columns, headers. Make sure to identifying row and 

columns headers directly in Microsoft Word, as those will be picked up on by 

screen readers. 

https://www.w3.org/WAI/tutorials/images/decision-tree/
https://www.w3.org/WAI/tutorials/images/decision-tree/
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○ The first row in a table should contain defined column headers 

(Design tab > Check header row). 

○ The first column in a table should contain defined row headers. You 

can check this from the table Design tab > First Column checkboxes. 

● Structure. Make sure the table has a simple structure, avoiding merged or 

split cells. Use the Tab key to ensure the order of the cells is logical. 

● Use proportional sizing for easier readability. 

● Tables should not be used for decorative purposes, such as the visual 

layout of the document. Additionally, tables shouldn’t use blank columns or 

rows for visual formatting purposes. 

1.2.5 Accessibility checker in Word 

Microsoft Word offers a valuable accessibility checker under the Review menu, a 

tool that will automatically scan the document for any pending accessibility issues 

and provide suggestions and means to fix the issues. For example, it will 

automatically pick up on any images without alt text and ask you to provide it – or 

to mark the image as decorative, which will provide an empty alt text. Similarly, it 

will suggest possible hard-to-read text based on colour contrast, possible reading 

order issues, or suggest general improvements to the logical structure of the 

document. 

1.3 Accessibility of PDFs 

Similarly to Word documents, most of the good practices mentioned in section 1.1 

can be useful in creating accessible PDF documents as well – for example, logical 

content order, readability, colour contrast of both text and non-text elements, 

images and links. To avoid being repetitive, this section will focus on good practices 

specific to PDF documents. 

The process of creating accessible PDFs starts from considering accessibility before 

converting a document to PDF. For example, if the source file is a Word document 

that will later be converted to a PDFs, firstly refer back to section 1.2 on how to 

make a Word document accessible. Many of the features will be transferred during 

the conversion to PDF including, for example, the table of content and logical 

structure of the document – with headings, subheadings, and paragraph text. 
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Additionally, if all images have been provided with alt text correctly, the PDF will 

automatically keep the alt text and correctly identify decorative versus informative 

images in the documents. 

1.3.1 Document properties 

To be accessible, a PDF document must provide some information in the document 

properties that would allow screen reader users to identify it. The main 

characteristics are the following:  

● Title of the document. The title of the document is the first thing read by a 

screen reader when opening the document. It should describe the document. 

● Language of the document. It allows screen readers to identify which 

language the document should be read in. 

● The filename. The name of the file is a metadata too, and should be as 

meaningful as possible. Avoid special characters that are not well supported 

in other operating systems and avoid making it too long. 

All of these elements can be edited in File > Document properties in Adobe 

Acrobat. 

1.3.2 Tagging the PDF document 

PDF tags are necessary to allow assistive technologies to correctly interpret the 

document. When a document has been converted to PDF, check the PDF tags in a 

PDF editor such as Adobe Acrobat and ensure that: 

● The document’s structure is correctly rendered. Semantic elements 

(headings, paragraphs, lists, etc.) should be correctly identified as such in the 

tags list. A document without semantic tags is a document whose structure 

won’t be communicated to screen readers’ users. 

● The reading order is correct. The document’s elements should appear in 

the tags list in a logical order, meaning the order in which the elements are 

supposed to be read. To manually check the reading order, select a tag in the 

tag list; the element it refers to will be highlighted in the document. Browse 

the whole document that way. 

● Figure tags have a text alternative. Figures include images, icons, 

graphics, charts, etc. Provide a textual description for those elements in the 

alt-text attribute so that screen reader users can access this information too. 
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● Tables are correctly tagged. Identify the heading cells of a table with the 

correct tag. A data table should always have at least one heading row or 

column. 

● Long documents contain bookmarks. Bookmarks allow users to navigate 

within the document, which is particularly useful for users of assistive 

technology when reading long documents. To generate bookmarks, open the 

“Bookmarks” navigation panel of Adobe Acrobat and select “New bookmarks 

from structure”. You should first ensure that the document’s structure and 

headings’ hierarchy is appropriate before generating bookmarks. 

1.3.2 Accessibility checker in Adobe Acrobat 

Similarly to Microsoft Word, Adobe Acrobat also includes a valuable accessibility 

checker that will automatically scan the document for any pending accessibility 

issues and provide further information and context on the detected issues, as well 

as potential fixes. For example, it will detect any non-tagged elements to be added 

to the tag tree, automatically pick up on any images without alt text and ask you to 

provide it or to mark the image as decorative, and will suggest possible reading 

order issues or suggest general improvements to the structure of the document. 

The accessibility checker in Adobe Acrobat can be accessed from More > Prepare 

for accessibility. 

In addition, the Adobe Acrobat website offers a detailed guide on how to make PDF 

documents accessible. 

1.4 Accessibility of videos and other media 

Accessibility of audio and video content starts from the planning stage: planning for 

accessibility from the very beginning of your project (during planning, scripting and 

storyboarding) is a time- and money-saving good practice. 

In addition, consider that not all media players are accessible to people with 

disabilities or vulnerable users. Accessible media players allow users to navigate 

their interface without a pointing device, through speech interface, and with screen 

readers. They are keyboard accessible and provide clear labels of each navigation 

element. They might have additional features such as changing the speed of the 

https://helpx.adobe.com/acrobat/using/creating-accessible-pdfs.html#:~:text=To%20tag%20a%20PDF%20in,reading%20order%20of%20each%20page.
https://helpx.adobe.com/acrobat/using/creating-accessible-pdfs.html#:~:text=To%20tag%20a%20PDF%20in,reading%20order%20of%20each%20page.
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video, interactive transcripts, or changing the size and style of the displayed 

captions. Different options of accessible media players are available for comparison. 

1.4.1 Captioning and transcripts 

Captions serve the purpose of collecting all audio information and describing them 

using text. They include both spoken content and non-speech information such as 

speech and sound effects, music, and the location/identification of a speaker if, for 

example, they are speaking off-screen. Captions appear on the screen on top of the 

visual elements in the video and are synchronised so that they appear at the same 

time as they are said by the speaker. 

Captioning is a necessity for people who are unable to hear audio in a video, and it 

is also beneficial for people with other cognitive impairments. In addition, it helps 

with developing literacy in a language, both in children and adults. There are two 

types of captioning: 

● Open captions – words will automatically appear on the video; you cannot 

turn them off. 

● Closed captions – the words won’t appear unless you turn them on. You can 

also turn them off. 

Please note that captions are different from subtitles. Captions are usually in 

the same language as the spoken words, while subtitles usually translate text into 

another language. 

Transcripts, on the other hand, are beneficial to users who can neither hear nor see 

the video, but are more generally helpful for any user who is unable to access the 

content from either web audio or video. A transcript should include spoken words, 

descriptions of the main audio information (e.g. laughter or other sound effects) 

and visual information (e.g. someone making a specific movement or act) of the 

scene. 

In addition, transcripts make multimedia content searchable by search engines, 

increasing the quality of the search, and are also used by screen readers. 

http://kensgists.github.io/apt/
http://kensgists.github.io/apt/
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All multimedia content including speech in some form should include accessible 

captions that are synchronised to appear on the screen at the same time as the 

corresponding words are spoken, equivalent to the spoken words and other sound 

effects, and readily available to users needing them. A few items to consider are 

the following: 

● Descriptions. Use descriptive language as much as possible to denote 

specific audio and visual elements accompanying the spoken scenes, and use 

easy-to-understand language for such descriptions. They should effectively 

describe sounds that have no visual equivalent in the video and the tone of 

voice, especially if different from the facial expressions of the speaker. 

● On YouTube. YouTube has a feature that will automatically caption videos up 

to a certain length. While this tool is helpful, it can still be inaccurate at times, 

so it is always preferable to prepare and upload your own accurate transcript 

and captions as much as possible. You can directly add or edit captions from 

YouTube Studio, via its Captions Editor. 

●  Create captions from scratch. To manually create captions for videos, 

there are a range of tools that can help, such as Amara, CADET or Jubler. A 

typical caption file has the .srt file extension and can be edited on Notepad on 

Microsoft Windows or TextEdit on Mac. It should always have the following 

structure, where each subtitle line is numbered, and timestamps are 

included: 

1 

00:05:00,400 --> 00:05:15,300 

This is a subtitle example. 

 

2 

00:05:16,400 --> 00:05:25,300 

This is an example of another subtitle. 

https://amara.org/
https://amara.org/
http://ncamftp.wgbh.org/cadet/
http://ncamftp.wgbh.org/cadet/
https://www.jubler.org/
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1.4.2 Audio description 

Audio description, also known as descriptive video or video description, is an 

additional audio track added to a piece of content describing and giving context for 

essential visual information. Audio description makes media accessible to people 

with visual impairments or who are blind by describing what is happening on screen 

through an audible description that is played during the natural pauses in the audio 

track of the media. 

It is similar to the concept of alternative text (alt text) to describe an image or a 

website but applied to videos and other kinds of multimedia. However, attaching a 

written description to your video’s visuals is not an equivalent of providing an audio 

description. There are three types of audio description: 

● Closed audio description – these descriptions are saved inside your video 

and can be turned on or off by the viewer as needed. 

● Open audio description – these descriptions automatically turn on when 

you click play, and can’t be turned off. 

● Real-time audio description – live commentary or narration by a trained 

audio describer via headphones and a small transmitter. It is often applied to 

performances, in-person tours, and other live events, as opposed to pre-

recorded videos. 

Audio descriptions can be provided together with the main video, as a separate 

audio track or as an alternative version of the video including audio descriptions. 

While audio descriptions might be quite costly and time-consuming to produce, they 

might be unnecessary if the audio track is already presenting the visual content in 

an accessible way. For example, instead of having a speaker say “Click here and 

there”, they should describe what is going to be clicked instead. Instead of saying 

“As you can see from the three key elements above”, the speaker could directly 

read aloud and describe the three key elements. 
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1.4.3 Social media and other elements 

There are several misconceptions and assumptions around users with specific needs 

and people with disabilities and their use of social media, for example that social 

media tools are completely accessible and can be used without limitation, and that 

the information distributed via social media is accessible and effective for all. Once 

again, good practices outlined in section 1.1 can be applied to producing accessible 

social media content as well, and especially readability, simple language and colour 

contrast of text and non-text elements. 

Social media posts and other content can be made accessible to people with 

disabilities and vulnerable users by bearing in mind a few key elements: 

● Visibility and reachability. Make sure your contact information is available 

on your social media account profile page, to allow users to easily reach you 

with any questions. Similarly, make your content available on more than one 

social media platform. 

● Content writing. When preparing text content for social media platforms, 

avoid acronyms and abbreviations that might not be of immediate 

understanding, limit the number of hashtags and place them within or at the 

end of the tweet. Once again, use plain language. 

● Attached media. Briefly describe any attached media (photo, video or audio 

content) that conveys meaningful information. Make your social media post 

act as a descriptive caption providing context for the item. Furthermore, you 

should link back to a webpage that hosts a tagged photo, captioned video or 

audio with full transcript for a full understanding. 

● Specific tips for Facebook. When uploading a photo on Facebook, make 

sure to add captions – these do not need to be too long but should be 

descriptive of what the scene is and how the different elements appear on the 

picture, providing context. When uploading a video on Facebook, make sure 

to also upload the related .srt file to allow for open captioning. 

● Specific tips for Twitter. Whenever you are including a link in your tweet, 

consider providing an indication of whether the link is a photo, video or audio 

file, as this will allow screen reader users to know that they should be 

expecting before opening a link (e.g.: [VIDEO]). Lastly, make sure that you 

are always linking to accessible content or, whenever it is not possible to 
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determine if the content you are redirecting to is accessible, include a 

disclaimer so that the target audience is aware of the limitations. 

● Specific tips for Instagram. Instagram continues to progressively include 

features to increase accessibility in posts and stories. Although these may 

vary depending on your geographical area and device used, a feature 

allowing for live captioning of Instagram Stories is now available to some 

users. In any case, it is always preferable to include captions of Instagram 

spoken stories, and to be especially descriptive and detailed in Instagram 

post captions. Good practices related to readability and colour contrast may 

apply to Instagram Stories as well. 

  



 

33 

 

Ensuring accessibility in content for all 
 
      

2. Case study: the child-friendly version 
of the BIK+ strategy 

On Wednesday, 11 May 2022, the European Commission adopted a new European 

strategy for a Better Internet for Kids (BIK+), to improve age-appropriate digital 

services and to ensure that every child is protected, empowered and respected 

online. 

The new European strategy for a Better Internet for Kids aims for accessible, age-

appropriate and informative online content and services that are in children's best 

interests. The updated BIK+ strategy is the digital arm of the European Union’s 

Strategy on the Rights of the Child, which has the following objective: to develop 

and promote child-friendly versions of laws and policies. 

As part of the plans to ensure a safer online experience for all children and young 

people, it was pivotal to address them directly and provide them with the necessary 

tools to learn how to safely access and enjoy what the online world has to offer, 

and to be aware of potential risks and concerns. Thus, a child-friendly version of 

the BIK+ strategy was developed, starting from the key principles (or pillars) of the 

strategy and adapting the language and visual style to target a younger audience. 

The making of the child-friendly version of the strategy would not have been 

possible without the crucial contribution of young people themselves. Indeed, a 

number of BIK Youth Ambassadors from all over Europe were consulted during the 

process, and provided invaluable feedback and assistance on the tone, style, and 

content of the child-friendly version. 

The accessible, child-friendly version of the new BIK+ strategy is now available in 

all EU languages and a variety of non-EU languages. Download the English version 

in PDF or access the translations of the child-friendly version in all EU and a range 

of non-EU languages. 

https://digital-strategy.ec.europa.eu/en/library/digital-decade-children-and-youth-new-european-strategy-better-internet-kids-bik
https://digital-strategy.ec.europa.eu/en/library/digital-decade-children-and-youth-new-european-strategy-better-internet-kids-bik
https://commission.europa.eu/strategy-and-policy/policies/justice-and-fundamental-rights/rights-child/eu-strategy-rights-child-and-european-child-guarantee_en#:~:text=In%20the%20EU%20Strategy%20on,be%20designed%20without%20their%20voices.
https://commission.europa.eu/strategy-and-policy/policies/justice-and-fundamental-rights/rights-child/eu-strategy-rights-child-and-european-child-guarantee_en#:~:text=In%20the%20EU%20Strategy%20on,be%20designed%20without%20their%20voices.
https://digital-strategy.ec.europa.eu/en/library/child-friendly-version-european-strategy-better-internet-kids-bik
https://digital-strategy.ec.europa.eu/en/library/child-friendly-version-european-strategy-better-internet-kids-bik
https://www.betterinternetforkids.eu/documents/167024/6945471/BIK%2B+strategy_accessible_final.pdf/a48709eb-4559-85a9-17db-d3446f431736?t=1657535981762
https://www.betterinternetforkids.eu/documents/167024/6945471/BIK%2B+strategy_accessible_final.pdf/a48709eb-4559-85a9-17db-d3446f431736?t=1657535981762
https://europa.eu/!wqYV6V
https://europa.eu/!wqYV6V
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2.1 Content: creating a child-friendly version of a policy 

document 

The aim was to involve young people in the drafting of the content of the child-

friendly version of the BIK+ strategy, using an iterative process. After getting a first 

sight of the text of the strategy on 11 May 2022, the launch day for the child-

friendly version was 21-22 June 2022 at the Digital Assembly in Toulouse, France, 

leaving less than six weeks to finalise the text. 

Some of the key aspects in the drafting of the child-friendly version of the strategy 

were: 

● Providing clear information and emphasising how the strategy can be 

beneficial to children and young people, and how they can make their voice 

heard. 

● Using a simple, child-friendly language: avoiding passive verb forms, 

using easy-to-understand vocabulary and short sentences, removing 

unnecessary references, avoiding the use of policy jargon or providing an 

explanation when unavoidable, highlighting key terms and concepts. 

○ Additionally, the child-friendly version includes a guide to explain some 

of the more specific jargon used in the leaflet, providing further context 

and information about the development of the strategy. 

● Consider the age group of your target audience, as the material will need to 

be adapted differently. 

● When producing child-friendly content, you should be aware of 

oversimplifications: it is important not to patronise children and young 

people, and bear in mind that their understanding of these matters might be 

more extensive than expected. 

See below a recollection of the content writing process, together with young people. 
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As you can see above, some of the suggestions from the young people included 

making certain sections of the text more concise, highlighted specific words that 

were repetitive or passive, or not child-friendly, and suggested replacements for 

them when it was not possible to leave them out altogether. They also assessed the 

general tone (“easy to understand for a range of ages, as well as hopeful and 

motivating”) and additional features of the text such as highlighting key words 

using a different colour/bold font. 

2.2 Design: creating a child-friendly visual template 

While young people were being consulted on the quality and child-friendliness of 

the text, the design was being developed in parallel, incorporating the existing 

visual identity set out by EC for the BIK+ strategy. Young people were presented 

with two possible designs and equally consulted on the design and visual aspect of 

the child-friendly version of the BIK+ strategy. 

Some of the key aspects in developing the visual template were: 

1. Visually clear, easy-to-read structure with headings and sub-headings to 

contribute to building a logical order to facilitate comprehension. 

2. Use of decorative items to break down text and as conceptual bullet points, 

sometimes substituting text when redundant. 
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3. Use of icons to help understand policy jargon and complement definitions of 

more complicated terms. 

Please find below some examples of the aforementioned good practices put into 

practice. First of all, in terms of general look, we had two main design options, for 

which we collected feedback from young people. They preferred the “purple 

version” over the “white” one. 

 

As far as the structure of a sample page from the document, we made sure to 

clearly identify headers from the other parts of the text, reduce the text to the 

necessary minimum and use icons and other decorative items to break down 

complex passages and reinforce the logical order of the document. 



 

37 

 

Ensuring accessibility in content for all 
 
      

 

2.3 Ensuring accessibility 

The accessibility of the resulting PDF document was enforced following the good 

practices mentioned in section 1.1 and section 1.3 above. In particular: 

● Document properties. Under File > Document properties > Description, 

there are a handful of parameters to consider: the document title which will 

be read out by the screen reader (as opposed to the filename), the author of 

the document, subject and keywords can also be added. The document 

should appear as “Tagged PDF”. Under the security tab, Content Copying for 

Accessibility should be allowed. The language of the document (under 

Advanced) should also be set for the screen reader to pick the appropriate 

accent. See below some of the settings of the document properties. 
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● Colour contrast. Refer to section 1.1.4 for detailed information about colour 

contrast. 

● Bookmarks. To add a new bookmark, select the text in the document first 

and then use the “Add bookmark” button. See below an example of a good 

bookmark structure based on the child-friendly version of the BIK+ strategy. 
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● Reading order. The reading order can be checked from Edit PDF > Reading 

Order. Boxes will appear around each text element of the page with a number 

in the top right corner showing the reading order, which can be changed from 

Edit PDF > Reading Order > Show Reading Order Panel. 

● Tag tree. All content in the PDF document should be correctly tagged – for 

example, <P> for paragraphs, <H1>, <H2>, etc. for headings and 

subheadings, <Link> for links – and should show on the tag tree of the 

document, which can be accessed from Edit PDF > Tags. 

See examples below of a correct tag tree based on the child-friendly version of the 

BIK+ strategy, and how to access and edit the reading order of a PDF document. 
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2.4 Translating the child-friendly version into other 

languages 

Once the English text of the child-friendly version of the BIK+ strategy was finalised 

after several rounds of consultation with young people, the text was professionally 

translated into all EU languages, as well as a range of non-EU languages. The 

translations soon showed that even a professional translation does not 

automatically ensure the same level of child-friendliness and clarity of the content 

in other languages, as each has a certain degree of nuance and specificities that 

cannot be picked up by translating services. 

For this reason, the Insafe network of Safer Internet Centres was later consulted to 

provide feedback and amend the proposed translations, given their expertise in the 

topic matters and their experience in working with children and young people 

directly, therefore having a more comprehensive understanding on the best 

vocabulary and tone to convey the message. 
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3. Conclusions

This guide aimed to provide a series of useful tips and good practices to correctly 

identify and approach the most common accessibility issues in web content, Word 

and PDF documents, and other media. The aim was to provide guidance and 

support to the Insafe network of Safer Internet Centres (and possibly beyond that) 

bearing in mind the limited access to tools and resources to check and enforce 

accessibility compliance, and the underlying limited knowledge of accessibility 

criteria in general. 

In addition, the guide was developed with content managers and content editors as 

the primary recipients of the information, thus focusing on good practices that 

everyone can apply when producing content rather than on the more technical 

aspects, without having to rely heavily on webmasters and web developers, which 

might involve additional costs for the Safer Internet Centre. Content managers and 

editors might want to refer to the checklist in Annex I summarising the main 

accessibility criteria introduced in this guide when producing or revising content. 

It should be noted that while it is important to ensure accessibility in content as 

much as possible, it is also important to acknowledge that there might be certain 

limitations – these could be operational or financial reasons that might limit or 

tamper the development of the design of a website, or a specific document or other 

piece of content – that make it impossible to meet all accessibility criteria at all 

times. This should not discourage content managers and content editors to continue 

their efforts in producing increasingly accessible content as it will be beneficial to 

their target audience, and potentially increase their target audience, but to bear in 

mind that ensuring accessibility is a learning process that is constantly evolving and 

requires continuous effort. 

To encourage this progressive learning, it is worth mentioning that there are some 

free online courses available to all to get introduced to the most common 

accessibility requirements and issues, and to increasingly build knowledge on 

accessibility good practices. Some examples include the ERASMUS+ Certified Digital 

https://digital-accessibility.eu/
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Accessibility Training project by Digital Accessibility EU, the Introduction to Web 

Accessibility course and the Tutorials by the Web Accessibility Initiative (WAI).   

https://digital-accessibility.eu/
https://www.edx.org/course/web-accessibility-introduction
https://www.edx.org/course/web-accessibility-introduction
https://www.w3.org/WAI/tutorials/
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4. Sitography and useful links 

Policy documents 

Accessibility requirements for ICT products and services 

Digital Strategy | Web Accessibility 

European Accessibility Act 

European strategy for a Better Internet for Kids (BIK+) 

European Union’s Strategy on the Rights of the Child  

Web Accessibility Directive (EU) 2016/2102 

Web Accessibility Initiative (WAI) | Accessibility requirements 

Web Content Accessibility Guidelines (WCAG)  

Accessibility tools 

Accessible colours | Colour contrast checker 

Accessible media players comparison table 

Amara | Subtitling tool 

CADET | Subtitling tool 

ColorZilla | Colour contrast checker (browser extension) 

Jubler | Subtitling tool 

Screen reader options | JAWS, NVDA, VoiceOver, Talkback, Dolphin, Narrator. 

WAVE | Web Accessibility Evaluation Tools 

Web Accessibility Initiative (WAI) | Alt text decision tree 

Web Accessibility Initiative (WAI) | Web Accessibility Evaluation Tools List 

WebAIM | Contrast checker 

https://www.etsi.org/deliver/etsi_en/301500_301599/301549/03.02.01_60/en_301549v030201p.pdf
https://digital-strategy.ec.europa.eu/en/policies/web-accessibility
https://ec.europa.eu/social/main.jsp?catId=1202
https://digital-strategy.ec.europa.eu/en/library/digital-decade-children-and-youth-new-european-strategy-better-internet-kids-bik
https://commission.europa.eu/strategy-and-policy/policies/justice-and-fundamental-rights/rights-child/eu-strategy-rights-child-and-european-child-guarantee_en#:~:text=In%20the%20EU%20Strategy%20on,be%20designed%20without%20their%20voices.
https://eur-lex.europa.eu/eli/dir/2016/2102/oj
https://www.w3.org/WAI/fundamentals/accessibility-principles/
https://www.w3.org/WAI/WCAG21/quickref/
https://accessible-colors.com/
http://kensgists.github.io/apt/
https://amara.org/
http://ncamftp.wgbh.org/cadet/
https://www.colorzilla.com/
https://www.jubler.org/
https://www.freedomscientific.com/products/software/jaws/
https://www.nvaccess.org/download/
https://www.apple.com/voiceover/info/guide/_1121.html
https://support.google.com/accessibility/android/answer/6283677?hl=en
https://yourdolphin.com/ScreenReader
https://support.microsoft.com/en-us/windows/complete-guide-to-narrator-e4397a0d-ef4f-b386-d8ae-c172f109bdb1
https://wave.webaim.org/
https://www.w3.org/WAI/tutorials/images/decision-tree/
https://www.w3.org/WAI/ER/tools/
https://webaim.org/resources/contrastchecker/
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WebAIM | HTML Semantics and Accessibility Cheat Sheet 

WebAIM | Link contrast checker 

WebAIM | Word and PowerPoint Accessibility Evaluation Checklist 

Building knowledge 

200ok | Embedded YouTube content 

A11y project | Dyslexia fonts 

Adobe Acrobat | Creating accessible PDFs 

Digital Accessibility EU | ERASMUS+ Certified Digital Accessibility Training project 
(free online course) 

Google | Embedded Google Maps content 

Guide to designing accessible, WCAG-compliant focus indicators 

W3schools | Accessibility tutorial 

W3schools | Accessible link texts 

Web Accessibility Initiative (WAI) | Accessibility Fundamentals Overview 

Web Accessibility Initiative (WAI)| Diverse abilities and barriers of web content 

users 

Web Accessibility Initiative (WAI) | How to meet WCAG (quick reference) 

Web Accessibility Initiative (WAI) | Introduction to Web Accessibility (free online 
course) 

Web Accessibility Initiative (WAI) | Tutorials 

Web Content Accessibility Guidelines (WCAG) 2.1 | Levels of conformance for colour 
contrast 

Web Content Accessibility Guidelines (WCAG) 2.1 | Focus appearance requirements 

WebAIM | Introduction to Web Accessibility 

WebAIM | Guide to alt text 

WebAIM | Testing Web Content for Accessibility 

WebAIM | Typefaces and fonts 

https://webaim.org/resources/htmlcheatsheet/
https://webaim.org/resources/linkcontrastchecker/
https://webaim.org/resources/evaloffice/
https://www.200ok.nl/tips/youtube-embed/
https://www.a11yproject.com/posts/dyslexia-fonts/
https://helpx.adobe.com/acrobat/using/creating-accessible-pdfs.html#:~:text=To%20tag%20a%20PDF%20in,reading%20order%20of%20each%20page.
https://digital-accessibility.eu/
https://cloud.google.com/blog/products/maps-platform/improved-accessibility-maps-javascript-api
https://www.sarasoueidan.com/blog/focus-indicators/
https://www.w3schools.com/accessibility/index.php
https://www.w3schools.com/accessibility/accessibility_link_text.php
https://www.w3.org/WAI/fundamentals/
https://www.w3.org/WAI/people-use-web/abilities-barriers/
https://www.w3.org/WAI/people-use-web/abilities-barriers/
https://www.w3.org/WAI/WCAG21/quickref/?versions=2.0
https://www.edx.org/course/web-accessibility-introduction
https://www.w3.org/WAI/tutorials/
https://www.w3.org/TR/WCAG21/#contrast-minimum
https://www.w3.org/TR/WCAG21/#contrast-minimum
https://www.w3.org/WAI/WCAG22/Understanding/focus-appearance-minimum
https://webaim.org/intro/
https://webaim.org/techniques/alttext/
https://webaim.org/resources/evalquickref/
https://webaim.org/techniques/fonts/
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WebAIM | Web Accessibility Principles 

Other links 

Child-friendly version of the BIK+ strategy | Example of child-friendly, accessible 

PDF document available in English and in a range of EU and non-EU languages 

European Schoolnet’s EMINENT 2022 | Sample webpage for alt text for different 
image types 

European Schoolnet homepage | Example of good/bad link text 

One-pager checklist of accessibility criteria | Better Internet for Kids 

  

https://webaim.org/resources/quickref/
https://digital-strategy.ec.europa.eu/en/library/child-friendly-version-european-strategy-better-internet-kids-bik
https://www.betterinternetforkids.eu/documents/167024/6945471/BIK%2B+strategy_accessible_final.pdf/a48709eb-4559-85a9-17db-d3446f431736?t=1657535981762
https://europa.eu/!wqYV6V
http://www.eun.org/eminent-2022
https://www.eun.org/
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Annex I: Checklist for accessible 
content writing 

Structure 

 Does the page have a descriptive title? 

 Is the content structured with headings (<h1>, <h2>, <h3>...)? 

 Do the headings (<h[n]>) follow each other in a logical order?  

 Is the content correctly structured in paragraphs? 

 Are links visually distinguishable from normal text? 

Images 

 Do informative images have a description in the alt attribute? 

 Do functional images describe the action they trigger in their alt attribute? 

 Do decorative images specify an empty alt attribute? 

 If there is an image that contains text, can it be replaced with real text? 

 If the image of text cannot be replaced with real text, is the text described in the 
image’s alt attribute? 

 If there is real text on top of an image, does it have sufficient colour contrast? 

Videos 

 Do videos provide closed captions? 

 Do videos provide an audio description track? 

 If informative text is contained inside the video, is it narrated in the synchronised 
audio or transcribed in the captions? 

 If the video is in an embedded YouTube player, does it specify the "disablekb=1" 
parameter necessary to not interfere with assistive technologies? 

https://accessible-colors.com/
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Text 

 Don’t rely on colour only to communicate information (i.e: red or green as 
feedback). 

 Avoid jargon, technical terms, abbreviations and acronyms - if they are 
necessary, describe their meaning in their first occurrence. 

 Don’t put emphasis on text by using decorative means such as underlining the 
text, using bold or different text colours. 

 Avoid “Click here” links - instead, describe the action or destination. 

 Don’t use emojis or images in place of text. 

 

 

 



 

 

 www.betterinternetforkids.eu 

 
@Insafenetwork 

@safeinternetday 

 
facebook.com/saferinternet 

facebook.com/SaferInternetDay 

 
linkedin.com/company/better-internet-for-

kids 

 youtube.com/@insafe01 

     info@betterinternetforkids.eu 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

https://www.betterinternetforkids.eu/
https://twitter.com/Insafenetwork
https://twitter.com/safeinternetday
https://www.facebook.com/saferinternet/
https://eunorg-my.sharepoint.com/www.facebook.com/SaferInternetDay
http://www.linkedin.com/company/better-internet-for-kids
http://www.linkedin.com/company/better-internet-for-kids
https://www.youtube.com/@insafe01
mailto:info@betterinternetforkids.eu
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